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About these instructions
1 About these instructions
These instructions have been prepared with utmost care. They contain 
information and notes intended to ensure long-term and reliable operation.

Should you notice any discrepancies or if you have improvement requests, 
then we would be glad to receive your feedback through Customer 
Service ( p. 113).

Consider these instructions as part of the product and keep it easily 
accessible.

1.1 For whom are these instructions intended?
These instructions are intended for:

• Operators:
This group is familiar with the machine and has access to the 
instructions. Specifically, chapter Operation ( p. 17) is important 
for the operators.

• Specialists:
This group has the appropriate technical training for performing 
maintenance or repairing malfunctions. Specifically, the chapter 
Setup ( p. 97) is important for specialists.

Service Instructions are supplied separately.

With regard to minimum qualification and other requirements to be met 
by personnel, please also follow the chapter Safety ( p. 9).

1.2 Representation conventions – symbols and characters
Various information in these instructions is represented or highlighted by 
the following characters in order to facilitate easy and quick understanding:

Proper setting
Specifies proper setting.

Disturbances
Specifies the disturbances that can occur from an incorrect adjustment.

Cover
Specifies which covers must be disassembled in order to access the 
components to be set.
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About these instructions
Steps to be performed when operating the machine (sewing and 
equipping)

Steps to be performed for service, maintenance, and installation

Steps to be performed via the software control panel

The individual steps are numbered:
First step

Second step

The steps must always be followed in the specified order.

Lists are marked by bullet points.

Result of performing an operation
Change to the machine or on the display/control panel.

Important
Special attention must be paid to this point when performing a step.

Information
Additional information, e.g. on alternative operating options.

Order
Specifies the work to be performed before or after an adjustment.

References
 Reference to another section in these instructions.

Safety Important warnings for the user of the machine are specifically marked. 
Since safety is of particular importance, hazard symbols, levels of 
danger and their signal words are described separately in the chapter 
Safety ( p. 9).

Location
information

If no other clear location information is used in a figure, indications of right 
or left are always from the user's point of view.

1.

2.

…

•


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About these instructions
1.3 Other documents
The machine includes components from other manufacturers. Each man-
ufacturer has performed a hazard assessment for these purchased parts 
and confirmed their design compliance with applicable European and na-
tional regulations. The proper use of the built-in components is described 
in the corresponding manufacturer's instructions.

1.4 Liability
All information and notes in these instructions have been compiled in 
accordance with the latest technology and the applicable standards and 
regulations.

Dürkopp Adler cannot be held liable for any damage resulting from:

• Breakage and transport damages
• Failure to observe these instructions
• Improper use
• Unauthorized modifications to the machine
• Use of untrained personnel
• Use of unapproved parts

Transport
Dürkopp Adler cannot be held liable for breakage and transport damages. 
Inspect the delivery immediately upon receiving it. Report any damage 
to the last transport manager. This also applies if the packaging is not 
damaged. 

Leave machines, equipment and packaging material in the condition in 
which they were found when the damage was discovered. This will ensure 
any claims against the transport company.

Report all other complaints to Dürkopp Adler immediately after receiving 
the product.
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Safety
2 Safety
This chapter contains basic information for your safety. Read the instruc-
tions carefully before setting up or operating the machine. Failure to do so 
can result in serious injury and property damage.

2.1 Basic safety instructions
The machine may only be used as described in these instructions.

These instructions must be available at the machine's location at all times.

Work on live components and equipment is prohibited. Exceptions are 
defined in the DIN VDE 0105.

For the following work, switch off the machine at the main switch or 
disconnect the power plug:

• Replacing the needle or other sewing tools
• Leaving the workstation
• Performing maintenance work and repairs
• Threading

Missing or faulty parts could impair safety and damage the machine. 
Only use original parts from the manufacturer.

Transport Use a lifting carriage or stacker to transport the machine. Raise the 
machine max. 20 mm and secure it to prevent it from slipping off.

Setup The connecting cable must have a power plug approved in the relevant 
country. The power plug may only be assembled to the power cable by 
qualified specialists.

Obligations
of the operator

Follow the country-specific safety and accident prevention regulations 
and the legal regulations concerning industrial safety and the protection of 
the environment.

All the warnings and safety signs on the machine must always be in legible 
condition. Do not remove! 
Missing or damaged warnings and safety signs must be replaced 
immediately.

Requirements
to be met by

the personnel

Only qualified specialists may be used for:

• Setting up the machine
• Performing maintenance work and repairs
• Performing work on electrical equipment

Only authorized persons may work on the machine and must first have 
understood these instructions.
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Safety
Operation Check the machine during operating for any externally visible damage. 
Stop working if you notice any changes to the machine. Report any chang-
es to your supervisor. Do not use a damaged machine any further.

Safety
equipment

Safety equipment should not be disassembled or deactivated. If it is essen-
tial to disassemble or deactivate safety equipment for a repair operation, it 
must be assembled and put back into operation immediately afterward.

2.2 Signal words and symbols used in warnings
Warnings in the text are distinguished by color bars. The color scheme is 
based on the severity of the danger. Signal words indicate the severity of 
the danger.

Signal words Signal words and the hazard they describe:

Symbols The following symbols indicate the type of danger to personnel:

Signal word Meaning

DANGER (with hazard symbol)
If ignored, fatal or serious injury will result

WARNING (with hazard symbol)
If ignored, fatal or serious injury can result

CAUTION (with hazard symbol)
If ignored, moderate or minor injury can result

CAUTION (with hazard symbol)
If ignored, environmental damage can result

NOTICE (without hazard symbol)
If ignored, property damage can result

Symbol Type of danger

General

Electric shock
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Safety
Examples Examples of the layout of warnings in the text:

 This is what a warning looks like for a hazard that will result in serious 
injury or even death if ignored.

 This is what a warning looks like for a hazard that could result in seri-
ous or even fatal injury if ignored.

 This is what a warning looks like for a hazard that could result in 
moderate or minor injury if the warning is ignored.

Puncture

Crushing

Environmental damage

Symbol Type of danger

DANGER
Type and source of danger!
Consequences of non-compliance.

Measures for avoiding the danger.

WARNING
Type and source of danger!
Consequences of non-compliance.

Measures for avoiding the danger.

CAUTION
Type and source of danger!
Consequences of non-compliance.

Measures for avoiding the danger.
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Safety
 This is what a warning looks like for a hazard that could result in 
environmental damage if ignored.

 This is what a warning looks like for a hazard that could result in 
property damage if ignored.

CAUTION
Type and source of danger!
Consequences of non-compliance.

Measures for avoiding the danger.

NOTICE

Type and source of danger!
Consequences of non-compliance.

Measures for avoiding the danger.
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Machine description
3 Machine description

3.1 Components of the machine

Fig. 1: Components of the machine

(1) - Machine head
(2) - Quick-stop
(3) - Reel stand
(4) - Tabletop
(5) - Stand

(6) - Compressed air maintenance unit
(7) - Pedal
(8) - Compressed air gun
(9) - Main switch
(10) - Control panel

⑦

⑧

⑨

⑩

①

②

③

④

⑥

⑤
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Machine description
3.2 Proper use
The machine may only be used with sewing material that satisfies the 
requirements of the specific application at hand.

The machine is intended only for use with dry sewing material. The sewing 
material must not contain any hard objects.

The needle thicknesses permissible for the machine are listed in the 
Technical data ( p. 121) chapter.

The seam must be completed with a thread that satisfies the requirements 
of the specific application at hand.

The machine is intended for industrial use.

The machine may only be set up and operated in dry conditions on well-
maintained premises. If the machine is operated on premises that are not 
dry and well-maintained, then further measures may be required which 
must be compatible with DIN EN 60204-31. 

Only authorized persons may work on the machine.

Dürkopp Adler cannot be held liable for damages resulting from improper 
use.

WARNING
Risk of injury from live, moving and cutting 
parts as well as from sharp parts!
Improper use can result in electric shock, crushing, 
cutting and punctures.

Follow all instructions provided.

CAUTION

Non-observance will lead to property damage!
Improper use can result in material damage at the machine.

Follow all instructions provided.
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Machine description
3.3 Declaration of Conformity
The machine complies with European regulations ensuring health, safety, 
and environmental protection as specified in the declaration of conformity 
or in the declaration of incorporation.
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Operation
4 Operation
The operating sequence consists of several different steps. Fault-free 
operation is necessary in order to achieve a good sewing result.

4.1 Preparing the machine for operation

Complete the following steps in preparation of sewing before starting to 
work:

• Inserting or changing the needle
• Threading the needle thread
• Threading or winding the hook thread
• Adjusting the thread tension

WARNING
Risk of injury from moving, cutting and sharp 
parts!
Crushing, cutting and punctures are possible.

If possible, make preparations only when the 
machine is switched off.
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Operation
4.2 Switching on and off the machine

Fig. 2: Switching on and off the machine

Switching on the machine
To switch on the machine:

1. Turn the main switch (1) to the right into the I position.
 The following message appears on the display: 

Press the pedal backwards
2. Press the pedal back.
 The machine performs a reference run.

The main menu appears on the display.

Switching off the machine
To switch off the machine:

1. Turn the main switch (1) to the left into the 0 position.

(1) - Main switch

①
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Operation
4.3 Switching on Quick-stop
The quick-stop switch (1) can be used to immediately stop all working 
steps on the machine, e.g. after an operating mistake.

Fig. 3: Switching on Quick-stop

To switch on quick-stop:

1. Press the quick-stop switch (1).
 All working steps on the machine are immediately stopped.

(1) - Quick-stop switch

①
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Operation
4.4 Changing the needle

Fig. 4: Changing the needle

To change the needle:

1. Push the hand crank (1) down and rotate it to the left until the needle 
bar (2) reaches the highest position.

2. Loosen the screw (4).
3. Pull the needle downwards out of the needle bar (2).
4. Insert the new needle into the needle bar (2) until it reaches the end 

stop.
Important
The groove (3) must face toward the hook.

5. Tighten the screw (4).

WARNING
Risk of injury from sharp and moving parts!
Puncture possible.

Switch off the machine before you change the 
needle.
Do not reach into the needle tip.

NOTICE

Property damage may occur!
Machine damage possible from incorrect hook side clearance.

When switching to a different needle thickness, adjust the distance 
between needle and hook ( Service Instructions).

(1) - Hand crank
(2) - Needle bar

(3) - Groove
(4) - Screw

④

③

①

②
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Operation
4.5 Switching on threading mode

Fig. 5: Switching on threading mode

Switching on threading mode
To switch on threading mode:

1. Press the button (1).
 The machine is in threading mode.

The button (1) lights up.
The sewing feet are lowered.
The hook cover (2) is opened and lit.

Switching off threading mode
To switch off threading mode:

1. Press the button (1) again. 

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Prior to any maintenance or cleaning work, switch 
off the machine or set the machine to threading 
mode.
When threading mode is active, do not reach into 
the hook area until this is lit up.

(1) - Button for threading mode (2) - Hook cover

①

②

Operating Instructions 911-210-10 - 03.0 - 09/2021 21



Operation
4.6 Threading the needle thread

Fig. 6: Threading the needle thread

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Switch off the machine before threading the needle 
thread.

(1) - Thread lever
(2) - Needle thread regulator
(3) - Guide
(4) - Guide
(5) - Needle thread monitor
(6) - Needle thread clamp (optional)
(7) - Guide
(8) - Guide
(9) - Needle eye

(10) - Thread tensioning spring
(11) - Deflection
(12) - Guide
(13) - Guide
(14) - Tension
(15) - Tension
(16) - Guide
(17) - Hose guide

①

④
⑤

⑥

⑦
⑧
⑨

⑩

⑪

⑫

⑬
⑭
⑮

⑯

⑰

③

②
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Operation
To thread the needle thread:

1. Place the thread reel on the reel stand and guide the needle thread 
through the hole in the guide on the thread guide.

Important
The thread guide must be parallel to the reel stand.

2. Use compressed air to blow the needle thread through the hose 
guide (17).

3. Feed the needle thread through the guide (16).
4. Guide the needle thread counterclockwise around the tension (15).
5. Guide the needle thread clockwise around the tension (14).
6. Feed the needle thread through guides (13) and (12).
7. Guide the needle thread clockwise around the deflection (11).
8. Feed the needle thread under the thread tensioning spring (10), through 

the guide (3) and through the needle thread regulator (2) to the thread 
lever (1).

9. Feed the needle thread through the thread lever (1) and the guide (4).
10. Feed the needle thread through the needle thread monitor (5).
11. For machines with thread trimmer, insert the needle thread through 

the thread clamp (6).
12. Feed the needle thread through guides (7) and (8).
13. Thread the needle thread through the needle eye (9) in such a way 

that the loose thread end faces the hook.
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Operation
4.7 Adjusting the needle thread regulator
The needle thread regulator determines the needle thread quantity to 
be guided around the hook. The required thread quantity depends on the 
thickness of the sewing material, the thread strength, and the stitch length.

Larger thread quantity for
• thick sewing material
• high thread strengths
• large stitch lengths 

Lower thread quantity for
• thin sewing material
• low thread strengths
• small stitch lengths

Proper setting
The loop of the needle thread slides at low tension over the thickest point 
of the hook. The largest amount of thread is required, and the thread 
tensioning spring (1) should be pulled approx. 0.5 mm out of the lower end 
position.

Fig. 7: Adjusting the needle thread regulator

To adjust the needle thread regulator:

1. Loosen the screw (1).
2. Move the needle thread regulator (2):

• Lower thread quantity: Slide the needle thread regulator (2) to 
the right

• Larger thread quantity: Slide the needle thread regulator (2) to 
the left

3. Tighten the screw (1).

(1) - Screw (2) - Needle thread regulator

②

①
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Operation
4.8 Winding the hook thread
The separate winder allows the hook thread to be wound both during 
sewing and when the sewing process is stopped.

Fig. 8: Winding the hook thread

To wind the hook thread:

1. Place the thread reel on the reel stand and guide the hook thread 
through the hole in the guide on the thread guide.

Important
The thread guide must be parallel to the reel stand.

2. Insert the hook thread in a wavelike manner through the two rear holes 
of the thread guide plate (1): From top to bottom through the rear hole 
and from bottom to top through the left hole.

3. Feed the hook thread from top to bottom through the thread guide 
channel (2).

4. Guide the hook thread counterclockwise around the winding 
tensioner (3).

5. Insert the hook thread in a wavelike manner through the two remaining 
free holes of the thread guide plate (1): From bottom to top through 
the rear hole and from top to bottom through the front hole.

6. Feed the hook thread to the winder and clamp it behind the knife (6).
Make sure the thread is NOT under tension.

7. Tear off the hook thread.
8. Fit an empty bobbin on the bobbin shaft (5) and turn clockwise until it 

clicks into place.

(1) - Thread guide plate
(2) - Thread guide channel
(3) - Winding tensioner

(4) - Bobbin winder flap
(5) - Bobbin shaft
(6) - Knife

④

⑤
⑥①

②

③
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Operation
9. Press the bobbin winder flap (4) against the bobbin.
 The winder starts and stops automatically when the configured 

bobbin filling volume is reached. 

4.9 Changing the bobbin

Fig. 9: Changing the bobbin (1)

To change the bobbin:

1. Remove the sewing material holder (1) (for alternating clamps only).
2. Press the threading mode (2) button.
 The machine is in threading mode.

The button (2) lights up.
The sewing feet are lowered.
The hook cover (3) is opened and lit.

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Switch the machine to threading mode before 
changing the bobbin.
When threading mode is active, do not reach into 
the hook area until this is lit up.

(1) - Sewing material holder
(2) - Button for threading mode

(3) - Hook cover

② ③①
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Operation
Fig. 10: Changing the bobbin (2)

3. Swivel up the bobbin case retainer (5).
4. Remove the empty bobbin.
5. Insert a full bobbin.
Important
Insert the bobbin (4) so that it moves in the opposite direction of the hook 
when the thread is pulled out.

6. Feed the hook thread through the slot (8) in the bobbin case retainer.
7. Pull the hook thread under the tension spring (7).
8. Feed the hook thread through the guide (6) and pull it approx. 3 cm 

further until reaching the hook cover.
9. Hold the hook thread in place and close the bobbin case retainer (5).
10. Cut off the surplus thread above the hook cover (3)
11. Release the threading mode (2) button.
 The hook cover (3) swivels back to the original position.
12. Enter a bobbin change in the software ( p. 48).

(4) - Bobbin
(5) - Bobbin case retainer
(6) - Guide

(7) - Tension spring
(8) - Slot

⑦ ⑧

④

⑤

⑥
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Operation
4.10 Thread tension
Together with the hook thread tension, the needle thread tension influences 
the final seam pattern. With thin sewing material, excessive thread tension 
can lead to undesired ruffing and thread breaking.

Proper setting
If the tension of needle thread and hook thread is identical, the thread 
interlace lies in the middle of the sewing material.
Adjust the needle thread tension so that the desired seam pattern is 
achieved with the lowest possible tension.

Fig. 11: Thread tension

(1) - Identical needle thread and hook thread tension
(2) - Hook thread tension higher than needle thread tension
(3) - Needle thread tension higher than hook thread tension

③

②

①
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Operation
Adjusting the hook thread tension

Fig. 12: Adjusting the hook thread tension

The hook thread tension is generated by the tension spring (1) and adjusted 
via the adjusting wheel (2).

To adjust the hook thread tension:

1. Turn the adjusting wheel (2).
• Increase the hook thread tension: Turn the adjusting wheel (2) 

clockwise
• Reduce the hook thread tension: Turn the adjusting wheel (2) 

counterclockwise

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Switch off the machine before you adjust the hook 
thread tension.

(1) - Tension spring (2) - Adjusting wheel

① ②
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Operation
4.11 Swiveling the machine head up and down

4.11.1 Swiveling up the machine head

Fig. 13: Swiveling up the machine head

Important
The transport carriage (2) must be at the rear.

To swivel up the machine head:

1. Release the locking lever (4) under the tabletop.

WARNING
Risk of injury from moving parts!
Crushing possible.

When swiveling down the machine head, hold 
the machine head in place until it has returned to its 
position.

(1) - Head cover
(2) - Transport carriage

(3) - Latch
(4) - Locking lever

①

③

④

②
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2. Lift the machine head in the head cover area (1) and swivel up carefully.
 The latch (3) latches into place.

The space under the stand is now accessible.

4.11.2 Swiveling down the machine head

Fig. 14: Swiveling down the machine head

To swivel down the machine head:

1. Hold the machine head in the head cover area (1).
2. Release the latch (2).
3. Swivel down the machine head carefully.
4. Latch the locking lever (3) under the tabletop.

NOTICE

Property damage may occur!
Risk of machine damage from falling machine head.

When swiveling down the machine head, hold the machine head in 
place until it has returned to its position.

(1) - Head cover
(2) - Latch

(3) - Locking lever

①

②

③

Operating Instructions 911-210-10 - 03.0 - 09/2021 31



Operation
32 Operating Instructions 911-210-10 - 03.0 - 09/2021



Programming
5 Programming
Fig. 15: Programming

The control is operated via the control panel OP7000 (1) located on the 
right next to the machine head.

The screen is a touchscreen, i.e. the buttons are displayed on the screen 
rather than provided as physical buttons. Buttons or functions are activat-
ed by tapping the corresponding position on the monitor.

Activating a button/selecting an element:
To activate a button or select an element:

1. Press the corresponding button or element with your finger or a touch-
screen pen.

(1) - Control panel OP7000

①
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5.1 Structure of the software
You can create and manage seam programs and sequences via software. 
During sewing, these programs are called up and processed stitch by stitch. 

Information

Seam program:
A seam program consists of a seam contour with parameters defining 
the individual contour sections.
Up to 99 seam programs can be stored in the system.
Seam programs have a file suffix of .fnp911 after the filename.

Seam sequence:
Up to 30 seam programs can be combined in any order to form a seam 
sequence.
Up to 20 seam sequences can be stored in the system.
Seam sequences have a file suffix of .seq911 after the filename.

The software is also used to define general settings that apply to all pro-
grams. There are also technical menu items for testing and maintaining 
the machine.

5.2 Overview of the menu structure
The following table provides an overview of the menu structure and 
the function buttons on the start screen.

Menu items in popup menus

Menu item Function Sub-items Sub-items Described on

Datei (File) Open existing programs 
for sewing
Create new programs 
and copy or delete 
existing programs.

Löschen (Delete)  p. 69

Kopieren (Copy)  p. 68

Öffnen (Open)  p. 46

Neu (New) Nahtprogramm
(Seam program)

 p. 53

Nahtsequenz
(Seam sequence)

 p. 65

Speichern unter
(Save As)

 p. 67

Bearbeiten 
(Edit)

Define general settings 
for all programs or 
modify an existing 
program.

Maschinenparameter 
(Machine parameters)

 p. 70

Sequenz (Sequence)  p. 65

Nahtprogramm 
(Seam program)

Parameter  p. 59

Konturanpassung 
(Contour adjustment)

 p. 57

Konturtest 
(Contour test)

 p. 56
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5.3 Starting the software
After it was switched on, the machine performs a reference run. After this, 
the start screen is shown for a few seconds.

Fig. 16: Starting the software (1)

Here you can select the user interface language or use Service to 
quickly access the Multitest (Multi test) menu.

Extras Display options: 
Full-screen and zoom

Technician menu: 
Adjustments, system 
information and tests

Vollbild ein/aus 
(Full screen on / off)

 p. 45

Zoom ein/aus 
(Zoom on / off)

 p. 45

Service Einstellungen 
(Settings)

 p. 76

System-Information 
(System information)

 p. 83

Multitest (Multi test)  p. 79

Initialisierung und 
Update (Initialization 
and update)

 p. 84

Hersteller (nur für DA-Personal) 
(Manufacturer (for DA personnel only))

Korrektur 
(Correction)

Short-term sewing with 
other values

Fadenspannung 
(Thread tension)

 p. 47

Nähdrehzahl (Speed)  p. 48

Buttons on the start screen
Continue sewing the contour from a particular 
point

Reparatur-Modus 
(Repair mode)

 p. 50

Allow for a manual bobbin change Spulenwechsel 
(Bobbin change)

 p. 48

Reset counter to a particular value Zählerreset 
(Reset counter)

 p. 52

Menu items in popup menus

Menu item Function Sub-items Sub-items Described on

(1) - Button language selection (2) - Button Service

① ②
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Information
Both functions can also be selected later from within the program via 
the menu items Extras > Service. 
(See chapters Testing the functions of the machine p. 79) and 
Changing the language ( p. 77).)

If you do not press any buttons, the software automatically switches to 
the start screen after a few seconds.

Start screen
The start screen is displayed during sewing. When the machine is started, 
the start screen is opened with the settings of the last sewing program 
used.

Fig. 17: Start screen

Structure of the start screen
• Title bar (1)
This shows the version of the machine on the start screen. It also contains 
information on the menu item currently selected in the various menus.

• Status bar (2)
On the start screen, the seam sequence currently open is displayed here, 
and the time of day (11) is displayed at the right. It also bar contains 
information on the currently selected step in the various menus.

• Main window (3)
The contour to be sewn is displayed here.

(1) - Title bar
(2) - Status bar
(3) - Main window: Display of

the seam contour
(4) - Program bar
(5) - Menu bar: Popup menu

(6) - Button for resetting the counter
(7) - Button for bobbin change
(8) - Button of the current sewing

parameters
(9) - Button for Repair mode
(10) - Display of time of day

③

④
⑤

⑥
⑦

⑨

⑩

⑧

①
②
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• Program bar (4)
The seam programs of the seam sequence currently open are displayed 
in this line. The program currently being executed is highlighted in black. 
You can use the arrow buttons (6) at the right side of the bar to navigate 
along the bar and display any additional programs that do not fit on the bar.
If a seam sequence is not currently open but rather only a single seam 
program, then this program fills the entire bar.

• Menu bar (5)
The bar at the bottom contains the popup menu. This allows you to access 
the various different menu items for creating and editing seam programs 
and for performing settings and tests on the machine. An arrow (1) next to 
a menu entry indicates that pressing the entry will display further sub-items.

Fig. 18: Menu bar

• Button for resetting the counter (6)
This button can be used for resetting the counter for the sewn programs 
or sequences. The current counter value is displayed next to this button.

• Button for bobbin change (7)
This button is used to inform the system that a new bobbin has been in-
serted (e.g. after a color change). The hook thread capacity is displayed 
next to this button.

• Display of the current sewing parameters (8)
The current sewing parameters are displayed below the repair mode 
button:

•  - Seam pattern size

•  - Sewing speed

•  - Thread tension

•  - Stitch length

•  - Number of stitches / hook thread consumed

(1) - Popup arrows

①
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Information
You can use the buttons Speed, Thread tension and Stitch length to 
access the sewing parameters directly ( p. 59).

• Button for Repair mode (9)
The topmost button at the right side is used for switching the repair mode 
on and off. The current status (Ein (On)/Aus (Off)) is displayed 
next to the button.

5.4 General operation of the software

5.4.1 Entering a password
Depending on the setting (see chapter Changing the password 
options ( p. 76)) a password is only required for accessing the techni-
cal menus or must be entered every time the machine is started. 
Next, the password entry screen is displayed.

Fig. 19: Entering a password

To enter a password:

1. Use the numeric buttons (2) to enter the password.

Information
The default password on delivery is: 25483.
The password can be changed via the Extras menu ( p. 76). 
You can delete incorrect entries via the DEL button.

2. Press the OK button.
 The previously selected menu item opens.

(1) - Input field (2) - Numeric buttons

①

②
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5.4.2 Closing windows
A number of different buttons can be used for closing the currently open 
window.

5.4.3 Display principles

Fig. 20: Display principles

• The currently activated or selected element is highlighted with a dark 
background (2)

• Buttons that are not used in the current context are grayed out (1)

Button Meaning

At the upper right in the title bar of all windows:
 The program jumps back by one navigation level.

OK
CR

In windows with data entry or selection fields:
 The window is closed and the entered or selected data is adopted. 

DEL
Abbruch 
(Cancel)

In windows with data entry or selection fields:
 The window is closed and the entered or selected data is 

discarded.

(1) - Grayed-out: Deactivated element (2) - Dark background: Activated element

②

①
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5.4.4 Scrolling the display

Fig. 21: Scrolling the display

A scrollbar (1) is displayed on the right when a displayed image is larger 
than the screen height.

To scroll the display:

1. Drag the scrollbar (1) up or down.

5.4.5 Selecting options from a list
When selecting options, a distinction is made between round radio buttons 
and square check boxes.

Selection with radio buttons

Fig. 22: Selection with radio buttons

With round radio buttons only one of the displayed options can be 
selected.

(1) - Scrollbar

①

(1) - Radio buttons: Selected element

①
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To select options using radio buttons:

1. Press the desired option.
 The selected option (1) is marked with a dot.

Selection with check boxes

Fig. 23: Selection with check boxes

Square check boxes allow for the selection of multiple entries.

To select options using check boxes:

1. Press the desired check box.
 The selected entries (1) are marked with a cross.

(1) - Check box: Selected elements

①
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5.4.6 Using file filters

Fig. 24: File filter

When opening, copying or deleting seam programs a list of all available 
files is displayed.

You can use the filter functions to make the list more manageable:

To use file filters:

1. Press the Dateifilter (File Filter) button under the list.
 The file filter screen opens.
2. Press the desired filter criterion:

• .fnp911: Seam programs only

• .seq911: Seam sequences only

• All Files: Seam programs and seam sequences
3. Press the Öffnen (Open) button.
 The list is updated according to the selected filter.
42 Operating Instructions 911-210-10 - 03.0 - 09/2021



Programming
5.4.7 Entering text
A text entry window is displayed when text needs to be entered, e.g. for 
the name of a seam program.

Fig. 25: Entering text

Entering text
To enter text:

1. Use the keyboard (2) displayed to enter the text.

Switching between uppercase/lowercase
To switch between uppercase and lowercase:

1. Press the Aa (5) button.

Deleting the last character
To delete the last character:

1. Press the DEL (4) button.

Adopting the entered text
To adopt the entered text:

1. Press the OK (CR) (3) button.
 The entered text is adopted, and the text entry window is closed.

(1) - Input line
(2) - Keyboard
(3) - OK (CR): Adopt the entered text

(4) - DEL: Delete a character
(5) - Aa: Switching between uppercase/

lowercase

①

②

③
④
⑤
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5.4.8 Entering parameter values
A numeric entry window opens when numeric values for program or 
machine parameters need to be entered.

Fig. 26: Entering parameter values

The title bar (1) shows the parameter group.
The status bar (2) shows the name of the parameter currently being 
edited. The symbol (3) for the corresponding parameter is displayed 
below the parameter name.
The prescribed value range (4) for the parameter is displayed below the 
symbol (3).
The current valid value is displayed in the data entry field (5) below the 
value range (4).

Entering a value
To enter a value:

1. Press the desired value using the numeric buttons (6).

Deleting a value
To delete a value:

1. Press the DEL button.

Adopting a value
To adopt a value:

1. Press the OK button.
 The entered value is adopted, and the numeric entry window is 

closed.

(1) - Title bar
(2) - Status bar
(3) - Symbol

(4) - Value range
(5) - Input field
(6) - Numeric buttons

①

②
③
④
⑤

⑥
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5.4.9 Switching the full-screen display on and off
In order to see the seam contour in more detail you can switch the main 
window (1) to occupy the full screen and hide the buttons (2) on the right 
side of the start screen.

Fig. 27: Switching the full-screen display on and off

To switch full-screen on and off:

1. Press the menu items Extras > Vollbild ein/aus (Full-
screen on / off).

 The display switches to the respective mode.

5.4.10 Switching zoom on and off
You can magnify the display in order to see the seam contour in more 
detail. There is only one zoom level that can be switched on or off.

Fig. 28: Switching zoom on and off

To switch zoom on and off:

1. Press the menu items Extras > Zoom ein/aus (Zoom on / 
off).

 The display switches to the respective mode.

(1) - Full-screen switched off (2) - Full-screen switched on

① ②

(1) - Zoom switched off (2) - Zoom switched on

① ②
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5.5 Opening a seam program or seam sequence for sewing
To open a seam program or seam sequence for sewing:

1. Press the menu items Datei (File) > Öffnen (Open).
 The file selection screen is displayed.

All existing seam programs and seam sequences are displayed.

Information
You can use the Dateifilter (File Filter) to make the list 
more manageable ( p. 42).

Fig. 29: Opening a seam program or seam sequence for sewing

2. Press the desired file.
3. Press the Öffnen (Open) button.
 The seam program/seam sequence is opened on the start screen.
4. Press the pedal forwards.
 The seam program is sewn.
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5.6 Briefly sewing with modified values
If you wish to briefly sew with a special material or use a particular thread 
strength with different values, without changing the seam program, you 
can use the Korrektur (Correction) menu item to temporarily 
change the values for thread tension and speed. The values then apply to 
all subsequently executed seams until the machine is switched off. 

Important
If you wish to adopt the changes, you must modify and save the program. 
Otherwise, the values are automatically reset to the original settings when 
the machine is switched off. 

5.6.1 Sewing with a modified thread tension
To sew with a modified thread tension:

1. Press the menu items Korrektur (Correction) > Faden-
spannung (Thread tension).

 The window for changing the thread tension appears:

Fig. 30: Sewing with a modified thread tension

2. Enter the desired value.
3. Press the OK button.
 The value is adopted and used for all seams until the machine is 

switched off.
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5.6.2 Sewing with a modified speed
To sew with a modified speed:

1. Press the menu items Korrektur (Correction) > 
Nähdrehzahl (Speed).

 The window for changing the thread tension appears:

Fig. 31: Sewing with a modified speed

2. Enter the desired speed.
3. Press the OK button.
 The value is adopted and used for all seams until the machine is 

switched off.

5.7 Changing the bobbin/managing a thread breaking

The machine automatically detects when the hook thread has been used 
up and a new bobbin needs to be inserted.

In this case, or if thread breaking occurs, the Fadenriss behandeln 
(Manage Thread Breaking) window is automatically displayed.

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Switch the machine to threading mode before 
changing the bobbin.
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5.7.1 Changing the bobbin

Fig. 32: Changing the bobbin

To change the bobbin:

1. Press the Spulenwechsel (Bobbin change) button.
2. Change the bobbin ( p. 48).
3. Use the Vor (Forwards) and Zurück (Back) buttons to 

move to the point where sewing is to continue.
4. Press the Weiternähen (Continue sewing) button.
 The program jumps back to the start screen and sewing of the seam 

continues from the selected point.

5.7.2 Bobbin change without a request from the program
If you wish to independently insert a new bobbin without being requested 
to do so by the program, you have to press the Spulenwechsel (Bobbin 
Change) button on the start screen after changing the bobbin.
This will inform the program that a new bobbin has been inserted, causing 
it to resume counting thread consumption starting with the full bobbin 
capacity.

5.7.3 Updating the bobbin capacity
To update the bobbin capacity:

1. Press the button Spulenwechsel (Bobbin Change)  on 
the start screen.

 The counter for the bobbin capacity begins anew with a full bobbin.
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5.8 Continuing a seam after an error

5.8.1 Continuing a seam in Repair mode after an error
In Repair mode you can move to any desired point on the contour, e.g. in 
order to continue the seam program from this position after an error has 
occurred.

To continue a seam in Repair mode after an error:

1. Press the button Reparaturmodus (Repair mode)  on 
the start screen.

 The Reparaturmodus (Repair mode) window is displayed.

Fig. 33: Continuing a seam in Repair mode after an error

2. Use the Vor (Forwards) and Zurück (Back) buttons to move to 
the point where sewing is to continue.

OR

3. Use the buttons Vor ++ (Forwards) and Zurück ++ (Back) to skip to 
the beginning of the next or the beginning of the previous seam section.

4. Press the Weiternähen (Continue sewing) button.
 The program jumps back to the start screen and sewing of the seam 

continues from the selected point.
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5.8.2 Continuing a seam after thread breaking
When the machine was set up, the needle thread monitor mode that 
is supposed to be active was selected in the machine parameters 
(MP 3 ( p. 73)).
In the event of an error, the machine will undo a certain number of preset 
stitches and stop.

The control panel will show the display Fadenriss behandeln 
(Manage Thread Breaking):

Fig. 34: Continuing a seam after thread breaking

Continuing a seam
To continue a seam after thread breaking:

1. Re-thread the needle thread.
2. Use the Vor (Forwards) and Zurück (Back) buttons to move to 

the point where sewing is to continue.
3. Continue sewing.

Canceling sewing and starting a new seam
To cancel sewing after thread breaking and start a new seam:

1. Press the Abbruch (Cancel) button.
2. Remove the transfer plate.
3. Press the pedal backwards.
 The machine performs a reference run.
4. Press the pedal forwards.
 The machine moves to the loading position, and you can start a new 

seam.
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Checking or changing the bobbin
To change or check the bobbin:

1. Press the Spulenwechsel (Bobbin change) button.
 The display shows a prompt asking whether you wish to reset the 

bobbin counter.
2. Press the JA (YES) button if you wish to change the bobbin.
 The bobbin counter will be reset.
OR

3. Press the NEIN (NO) button if you merely wish to check the bobbin.
 The bobbin counter will not be reset.
4. Remove the transfer plate.
5. Press the Einfädelmodus (Threading mode) button on the machine 

head.
 The hook cover opens.
6. Change or check the bobbin.
7. Press the Einfädelmodus (Threading mode) button on the machine 

head.
 The hook cover closes.
8. Press the pedal forwards.
 The machine moves into the insertion position.
9. Insert the transfer plate.
10. Press the pedal or press the Weiternähen (Continue Sewing) button.
 The machine moves to the sewing position.
11. Press the pedal or press the Weiternähen (Continue Sewing) button.
 The sewing procedure is resumed.

5.9 Resetting the counter
Depending on the machine parameter settings, the counter counts 
the sewn programs or seam sequences up or down. You can use the 
Zähler-Reset (Reset Counter) button to reset the counter 
to the start value ( p. 75).

To reset the counter:

1. Press the button Zähler-Reset (Reset Counter)  on the 
start screen.

 The counter is reset to the value defined in the machine parameters.
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5.10 Seam programs and seam sequences

5.10.1 Creating a new seam program
New seam programs are created using a Teach-In procedure.
Individual seam paths with specific sewing parameters are defined via 
the control panel in order to do this.

To create a new seam program:

1. Press the menu items Datei (File) > Neu (New) > 
Nahtprogramm (Seam Program).

 The Teach-In window appears.

Fig. 35: Creating a new seam program

Defining the starting point
2. Define the starting point:

(1) - Cursor position
(2) - Cursor
(3) - Arrow buttons
(4) - OK button: Accept

(5) - Save button
(6) - Delete button
(7) - Parameter button
(8) - Line selection buttons

②

③ ④
⑤
⑥
⑦

⑧

①

Method Coordinate area

Using the arrow buttons (3)

Caution
For safety reasons, you cannot use the arrow buttons (3) 
to select a position beyond 90.1 or -92.6 on the Y-axis.
Settings beyond these coordinates require that you use 
the pedal.

X -150 to X 230
Y 90.1 to Y -92.6

Using the pedal

Every press of the pedal moves the cursor (2) by 0.1 in 
the direction of the selected axis (X or Y)

X -150 to X 230
Y 100 to Y -100

Entering coordinates directly via the cursor position (1) X -150 to X 230
Y 100 to Y -100
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3. Press the OK (4) button.
 The desired starting point is adopted and marked with a green / blue 

dot.

Selecting the line type
4. Use the line selection buttons (8) to select the type of line to be defined:

•   Seamless path: The clamp moves over this path to the next 
position without sewing

•   Straight seam: A straight path is sewn

•   Curved seam: A curve is sewn

 After pressing the button for a straight or curved seam, the correspond-
ing window for entering the sewing parameters for this path opens.

Defining the sewing parameters for the path

Fig. 36: Defining the sewing parameters for the path

5. Press the desired parameter.
 The window for entering the parameter value opens.
6. Enter the desired value for the parameter ( p. 44).

Sewing parameters for Teach-In
Button Meaning

Speed

Stitch length
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Drawing a path
7. Use the arrow buttons to move the cursor to the end point of the desired 

path.

Information
Alternatively, you can press an arrow button once in order to define the 
direction and then continue moving in this direction by pressing the pedal.

Important
Take care to ensure that the contour remains within the permissible 
sewing field of the machine.
Especially with curved paths, you should remember that the start and end 
points are not directly connected and that a curve is generated between 
these two points.

8. Press the OK button.
 The seam path is adopted with the specified parameters.

Adding further seam paths
You can now define all further seam paths in the same manner.

1. Begin every new seam path by selecting the type of line ( p. 54).

Deleting a seam path
1. Press the Löschen (Delete) button.
 The last section of the seam path is deleted. 

Thread tension

Stroke height

Thread cutting

Button Meaning
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Saving a seam program
After you have defined all the seam paths, you can save the seam program 
and specify a name for the program.

1. Press the Speich...(Save...) button.
 The window for entering the name of the seam program opens.
2. Enter the desired name ( p. 43) and adopt the change by pressing 

OK (CR).
 The seam program is now available under this name for sewing, 

editing or copying.
Important
Always perform a contour test after creating a new seam program 
( p. 56).

5.10.2 Performing a contour test
Perform a contour test every time after creating a new seam program or 
editing a seam contour to ensure that the contour you entered lies within 
the permissible sewing field.

To perform a contour test:

1. Press the menu items Bearbeiten (Edit) > Nahtprogramm 
(Seam program) > Konturtest (Contour test).

 The Konturtest (Contour test) window appears.

NOTICE

Property damage may occur!
If you have entered contour points that lie outside the sewing field, 
the movement of the clamps during sewing can cause damage to the 
machine or the sewing material.

Always perform a contour test after creating or editing a contour to 
ensure that the entire contour lies within the permissible sewing field.
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Fig. 37: Performing a contour test

2. Move along the contour stitch by stitch using the Vor (Forwards) and 
Zurück (Back) buttons or the pedal.

3. Check that all points lie within the sewing field.

5.10.3 Editing a seam program
You can change the contour and the sewing parameters of existing seam 
programs. The changes are applied to the seam program that is currently 
open on the start screen.

To edit an existing seam program:

1. Open the seam program you wish to modify via the menu items Datei 
(File) > Öffnen (Open).

 The seam program opens on the start screen.

Changing the contour of a seam program

To change the contour of a seam program:

1. Press the menu items Bearbeiten (Edit) > Nahtprogramm 
(Seam program) > Konturanpassung (Contour 
adjustment).

 The contour adjustment window appears:

NOTICE

Property damage may occur!
If you have entered contour points that lie outside the sewing field, 
the movement of the clamps during sewing can cause damage to the 
machine or the sewing material.

Always perform a contour test after creating or editing a contour to 
ensure that the entire contour lies within the permissible sewing field.
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Fig. 38: Changing the contour of a seam program (1)

2. Use the arrow buttons to move the cursor (1) to the position on 
the contour that is to be changed.

Information
You can also use the slider control on the scale (2) to select the stitching 
area you wish to change:
The first stitch of the seam pattern is at the top and the last stitch is at 
the bottom.

3. Press the Go To button.
 The selected contour region is displayed in detail.

The stitching point (2) to be modified is marked in red.

Fig. 39: Changing the contour of a seam program (2)

4. Use the arrow buttons to move the stitching point to the new position (4).
 The modified seam path is displayed in green.
5. Press the Weiter (Next) button.
 The window for selecting the technology operations opens.

(1) - Cursor (2) - Scale: First to last stitch

① ②

(3) - Old stitching point (4) - New stitching point

④

③
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Fig. 40: Changing the contour of a seam program (3)

6. Select the desired technology operation(s) for the new seam path 
( p. 40).

7. Confirm the selection with OK.
 You are returned to the detail window with the modified contour.
8. Press the Weiter (Next) button.
 A query dialog is displayed, asking if you wish to adopt the changes.

Confirm the query dialog with JA (YES) to save the modified contour.
Important
Always perform a contour test after modifying a contour to ensure that the 
new seam path lies within the permissible sewing field ( p. 56).

Changing seam program parameters
You can change the general settings that apply to the entire seam program.

To change the seam program parameters:

1. Press the menu items Bearbeiten (Edit) > Nahtprogramm 
(Seam program) > Parameter (Parameters).

 The window for selecting the program parameter group appears:
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Fig. 41: Changing seam program parameters

2. Press the desired parameter group.
 The individual parameters of this group are displayed.
3. Press the desired parameter.
 The window for modifying the parameter value opens.
4. Set the parameter to the desired value ( p. 44).
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There are 8 program parameter groups:

Overview of the individual program parameters

Symbol Parameter group

PP1 - Configuration
General settings

PP2 - Load mode
Load mode and position

PP3 - Deposit mode
Deposit mode and position

PP4 - Soft start
Number of stitches and speed

PP5 - Needle thread monitor
Sensitivity value for the needle thread monitor

PP6 - Thread consumption
Values for determining thread consumption

PP7 - Move:
Contour is moved in a particular direction

PP8 - Scaling: 
The size of the contour is changed.

PP1 - Configuration

Symbol Meaning

Seam name
max. 20 characters

Minimum sewing foot stroke height
(min. = 1.0 .. max. = 10.0; Def. = 5.0 mm )
Sets this as the minimum value of the programmable sewing foot stroke 
height so that only this value needs to be adjusted when sewing thicker 
materials.
Adjust thread tension
(min. = 10… max. = 200; Def. = 100 %)
The thread tension profile for the entire contour is adjusted accordingly. 
A value of 100% means that no adjustments are made.
Adjust empty-run speed
(min. = 10… max. = 200; Def. = 100 %)
The travel speeds are adjusted.

Clamp ID code
Barcode (ID code) of max. 10 characters for performing a safety check 
before the start of sewing (the barcode scanner additional equipment must 
be activated)
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Marking lamps
Up to 4 marking lamps for easier alignment of the sewing material can be 
controlled (the additional equipment must be activated)

Reversal mode 
The following options can be set:
• Not activated: The needle remains at the Stop position
• After the entire contour: After completing all seams in the contour, 

the needle is reversed to the value specified in the machine parameters
• After each seam (Def.): The needle is reversed after every seam
Needle cooling
(On / Off)
Activates/deactivates the needle cooling.

Adjust sewing speed
(min. = 10… max. = 200; Def. = 100%)
The sewing speed is adjusted by the specified percent value.

PP2 - Load mode

Symbol Meaning

Load mode
The following options can be set:
• Mode 1 (Def.)
The clamp is opened in the loading position. The clamp is closed when the 
pedal is pressed. Pressing the pedal again starts the sewing of the seam.
• Mode 2
The clamp is opened in the loading position. Pressing the pedal closes 
the left part of the two-piece clamp for angle mounting. Pressing the pedal 
again closes the right part. Another press of the pedal starts the sewing of 
the seam.
• Mode 3
The clamp is opened in the loading position. Pressing the pedal closes 
the right part of the two-piece clamp for angle mounting. Pressing the pedal 
again closes the left part. Another press of the pedal starts the sewing of 
the seam.
• Mode 4
Quick-start mode:
The clamp is opened in the loading position. The clamp is closed, and 
the sewing of the seam is started when the pedal is pressed. With the 
alternating clamp, the seam is automatically started after insertion.
This mode is only active when quick-start is activated in the machine 
parameters. The machine must be switched off and on in order to activate 
the quick-start mode.
• Mode 5
The clamp remains closed in the loading position. Pressing the pedal again 
starts the sewing of the seam.
Loading position
(On / Off)
With the loading position activated the clamps move to the desired position 
for convenient insertion of the sewing material.

Symbol Meaning
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Loading position X
The value range varies depending on the subclass and sewing field size.

 Loading position Y
The value range varies depending on the subclass and sewing field size.

PP3 - Deposit mode

Symbol Meaning

Deposit mode
The following options can be set:
• Mode 1 (Def.)
Clamp is opened in the removal position.
• Mode 2
The clamp remains closed in the removal position. The clamp is opened 
when the pedal is pressed. 
• Mode 3
The clamp remains closed in the removal position. Pressing the pedal 
opens the left part of the two-piece clamp for angle mounting. 
Pressing the pedal again opens the right part.
• Mode 4
The clamp remains closed in the removal position. Pressing the pedal 
opens the right part of the two-piece clamp for angle mounting. 
Pressing the pedal again opens the left part.
• Mode 5
Clamp remains closed in the removal position.
Removal position
(On / Off)
With the removal position activated the clamps move to the desired position 
for convenient removal of the sewing material after the sewing procedure.
Removal position X 
The value range varies depending on the subclass and sewing field size.

Removal position Y 
The value range varies depending on the subclass and sewing field size.

Symbol Meaning
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PP4 - Soft start

Symbol Meaning

Soft-start stitch count
(min. = 0.. max. = 10; Def. 5)

Soft-start speed
 (min. = 100 .. max. = 2000; Def. 300 rpm)

PP5 - Needle thread monitor

(min. = 0 .. max. = 99; Def. 5)
Only active if activated in the machine parameters.
(A higher value makes the needle monitor less sensitive. 
99 = Needle thread monitor switched off in this program only.)

PP6 - Thread consumption

Symbol Meaning

Sewing material thickness (min. = 0.. max. = 20.0; Def. 0)
 The thickness of the sewing material when pressed together.

Adjust thread consumption
 (min. = -10.0.. max. = 10.0; Def. 0)
 Correction of the calculated values.

PP7 - Move

Symbol Meaning

X move 
(min. = -5.0… max. = 5.0; Def. = 0.0 mm)

Y move 
(min. = -5.0… max. = 5.0; Def. = 0.0 mm)
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5.10.4 Creating a new seam sequence
You can combine up to 30 seam programs to form a seam sequence. 
You can create up to 20 seam sequences in total.

Selecting seam programs
To select seam programs:

1. Press the menu items Datei (File) > Neu (New) > Sequenz 
(Sequence).

 The window for selecting the seam program appears.

Fig. 42: Selecting seam programs

The existing seam programs are displayed at the right side of the screen. 
The field Sequenz (Sequence) field on the left shows the seam 
programs that have been transferred to the seam sequence.

PP8 - Scaling.

Symbol Meaning

X scaling 
(min. = 80… max. = 120; Def. = 100 %)
100% corresponds to the original size.

Y scaling 
(min. = 80… max. = 120; Def. = 100 %)

X scaling origin 
(min. = -150.0… max. = 150.0; Def. = 0.0 mm)

Y scaling origin 
(min. = -150.0… max. = 150.0; Def. = 0.0 mm)
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2. Press the desired seam program.
 The selected seam program is highlighted with a dark background.
3. Press the Einfügen (Insert) button.
 The seam program is transferred to the seam sequence and is 

displayed in the Sequenz (Sequence) field on the left side of 
the screen.

4. Add further seam programs in the same manner.

Removing a seam program from a seam sequence
To remove a seam program from a seam sequence:

1. Press the seam program in the Sequenz (Sequence) field and 
then press the Löschen (Delete) button.

 The seam program is removed from the seam sequence.

Assigning a name to a seam sequence
To assign a name to a seam sequence:

1. Press the Namen eingeben (Set name) button.
 The window for entering the name of the seam sequence opens.
2. Enter the desired name and adopt the change by pressing 

OK(CR) ( p. 43).
 The seam sequence is now available under this name for sewing, 

editing or copying.

5.10.5 Editing a seam sequence
You can edit an existing seam sequence by adding or removing seam 
programs.

To edit a seam sequence:

1. Open the seam program you wish to modify via the menu items Datei 
(File) > Öffnen (Open).

 The seam sequence opens on the start screen.
2. Press the menu items Bearbeiten (Edit) > Sequenz 

(Sequence).
 The window for editing the seam sequence appears.
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Fig. 43: Editing a seam sequence

3. Use the buttons Einfügen (Insert) and Löschen (Delete) to add 
programs to the seam sequence or remove programs from the seam 
sequence.

5.10.6 Saving a seam program or seam sequence under a different 
name

You can also save existing seam programs or seam sequences under a 
different name.

Information
If you wish to create a new program that is similar to an existing program, 
you do not need to create the entire program anew. You can save the 
existing program under a new name and then change the details you wish 
to modify.

To save a seam program or a seam sequence under a different name:

1. Press the menu items Datei (File) > Speichern unter 
(Save As).

 A selection window allowing you to select a seam program or seam 
sequence appears.

Information
You can use the Dateifilter (File Filter) to make the list 
more manageable ( p. 42).

2. Press the desired element.
3. Press the Speichern unter (Save As) button.
 The window for entering the new name is opened.
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4. Enter the desired name and adopt the change by pressing 
OK(CR) ( p. 43).

 The seam program or seam sequence is now available under this 
name for sewing, editing or copying.

5.10.7 Copying a seam program or seam sequence
You can also copy seam programs or seam sequences from a USB key 
to the control or from the control to a USB key.

Important
Not all commonly available USB keys are suitable for the copying process.
You can obtain a suitable USB key from Dürkopp Adler.

To copy a seam program or a seam sequence:

1. Press the menu items Datei (File) > Kopieren (Copy).
 The window for selecting the file to be copied appears:

Fig. 44: Copying a seam program or seam sequence

2. Use the buttons (1) to select whether the data is to be copied from 
the DAC control or the USB key.

 The selected button is highlighted with a dark background.
The files present at this location are listed in a selection window (2).

Information
You can use the Dateifilter (File Filter) to make the list 
more manageable ( p. 42).

3. Press the desired file.
 The selected file is highlighted with a dark background.

(1) - Select the source to be copied (2) - File selection window

① ②
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4. Press the Datei koperen (Copy File) button.
 The selected file is copied to the USB key or the control.

5.10.8 Deleting a seam program or seam sequence
Seam programs or seam sequences that are no longer required can be 
deleted from the control.

To delete a seam program or a seam sequence:

1. Press the menu items Datei (File) > Löschen (Delete).
 The window for selecting the file to be deleted appears:

Fig. 45: Deleting a seam program or seam sequence

Information
You can use the Dateifilter (File Filter) to make the list 
more manageable ( p. 42).

2. Press the desired file.
 The selected file is highlighted with a dark background.
3. Press the Löschen (Delete) button.
 The selected file is deleted.
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5.11 Editing machine parameters
You use the machine parameters to define the basic machine settings.
These basic settings apply to all programs.

To edit the machine parameters:

1. Press the menu items Bearbeiten (Edit) > Maschinen-
parameter (Machine parameters).

 The window for selecting the machine parameter group appears.

Fig. 46: Editing machine parameters

2. Press the desired parameter group.
 The individual parameters of this group are displayed.
3. Press the desired parameter.
 The window for modifying the parameter value opens.
4. Set the parameter to the desired value ( p. 44).

There are 6 machine parameter groups:

Symbol Parameter group

MP1 - Configuration
General settings

MP2 - Limit values
Limit values for speeds and positions

MP3 - Needle thread monitor
Behavior after thread breaking

MP4 - Thread cutting
Speed, position and tension

MP5 - Thread clamping
Starting angle

MP6 - Counters
Settings for program and bobbin counters
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Overview of the individual machine parameters

MP1 - Configuration

Symbol Meaning

Needle cooling 
The following options can be set:
• Without: No needle cooler activated.
• Air cooling (Def.): The needle is cooled with air while sewing the seam
• Ice cooling: Optional equipment
Sewing foot mode
The sewing foot can be operated in the following modes:
• Jumping foot: The sewing foot only presses on the sewing material 

while the needle is in the sewing material
• Presser foot: The sewing foot presses continuously on the sewing material
Sewing field size 
Take care to ensure a valid sewing field size for your subclass when making 
the selection! (See chapter Technical data ( p. 121))
• Normal sewing field (Def.): A sewing field of up to 200 x 300mm is 

available
• Extra-large sewing field: A larger sewing field can be used in conjunction 

with the alternating clamps
Optional equipment 
• Reduced clamp pressure: Optional equipment limiting the amount of 

clamp pressure to allow for better alignment on insertion. 
• Neat seam beginning: Optional equipment, activates stitch position 

optimization ( Additional Instructions Stitch Position Optimization)
• Marking lamps: Optional equipment providing orientation lines on insertion 

for easier alignment. Up to 4 marking lamps can be switched on for each 
program. This setting only activates the option, the actual switching is 
defined in the program parameters (see Marking lamps( p. 62)) 

• Barcode scanner: Optional equipment for performing a safety check 
before sewing. A barcode can be stored with each program. Agreement 
with the barcode on the clamp is checked. Sewing only proceeds when 
the barcodes agree. You enter the barcode ID in the program parameters 
(see Clamp ID code ( p. 61)).

Clamp type 
The following clamp types are available:
• Single clamp: One-piece parallel clamp with angle mount
• Single clamp with hanger (Def.): One-piece parallel clamp with hanger 

mount
• Double clamp: Two-piece parallel clamp with angle mount
• Alternating clamp: Removable clamp
• Special clamp: Special clamp
Clamp limitation 
• Preset limitation (Def.): No additional structures are taken into account
• Special limitation: Individual limits are taken into account
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Information
The remaining thread monitor (MP 1, Optionale Einrichtungen (Optional 
equipment)) and the bobbin counter (MP 6) can be activated simultaneously. 
The display shows the two options as follows:

Fig. 47: Remaining thread monitor and bobbin counter

Pedal mode 
The following options are available:
• Mode 1: The current position of the pedal is evaluated
• Mode 2 (Def.): The pedal must be returned to the initial position after 

every actuation before a new actuation is recognized
• Mode 3: The current position of the pedal is evaluated. The quick-start 

mode is also enabled (see Load mode ( p. 62)). The machine must 
be switched off and on in order to activate the quick-start mode.

• Push button: In push button mode one sensor is used only for controlling 
the clamp motion (up and down). The other sensor is used for starting the 
sewing process.

Barcode mode
The following options are available:
• Manual: Machine checks whether the inserted clamp matches the 

entered seam program. If the clamp is correct, the machine is ready for 
sewing. If the clamp is incorrect, an error message will be displayed, and 
the clamp will have to be replaced.

• Automatic: The machine looks for the seam program that matches the 
inserted clamp. The machine is ready for sewing once the seam program 
has been selected.

Symbol Meaning

(1) - Display - remaining thread monitor:
Remaining thread monitor active: 
R shown
Remaining thread monitor inactive: 
R hidden

(2) - Display - bobbin counter:
Bobbin counter active: Number black
Bobbin counter inactive: Number 
grayed-out

① ②
72 Operating Instructions 911-210-10 - 03.0 - 09/2021



Programming
MP2 - Limit values

Symbol Meaning

Max. speed 
(min. = 500 .. max. = 2700; Def. 2700 rpm)
All sewing programs are limited to this maximum speed

Max. run-empty speed 
(min. = 10 .. max. = 100; Def. 100 %)
Limits all clamp movements between the seams to this value

Feed starting angle 
(min. = 30 .. max. = 350; Def. 210 degrees)
The clamp motion during the stitch starts at this angle of needle motion

Feed phase 
(min. = 30 .. max. 100; Def. 80 %)
This parameter defines how the clamp is to be moved during the stitch. 
(A value of 100 % means that the desired clamp motion is distributed over 
the entire stitch.)
Reversal position 
(min. = 0 .. max. 359; Def. 0 degrees)
The needle is reversed at this angle in order to increase the clearance to 
the clamp.
 Edit times and routes
 This function is only for Dürkopp Adler Service personnel

MP3 - Needle thread monitor

Symbol Meaning

Needle thread monitor mode
The following options are available:
• Threading position: After detection of a thread breaking, the thread is 

cut, and the clamp then moves to the threading position
• Thread cutting (Def.): After detection of a thread breaking, the thread is 

cut, and the clamp then moves to the contour position according to the 
defined reversing path

• Pausing: After detection of a thread breaking, seam motion is stopped
• Not activated: The needle thread monitor is ignored
Reversing path after thread breaking 
(min. = 0 .. max. 20; Def. 5 stitches)
Number of stitches to be taken into account when reversing after a thread 
breaking
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Position of bobbin change X 
The value range varies depending on the subclass and sewing field size

Position of bobbin change Y 
The value range varies depending on the subclass and sewing field size

MP4 - Thread cutting

Symbol Meaning

Cutting speed 
(min. = 70 .. max. 500; Def. 150 rpm)
Speed of the cutting stitch

Cutting position on 
(min. = 0° .. max. 359°; Def. 180°)
Angular position of the needle at which the thread cutting knife is switched 
on
Cutting position off
(min. = 0° .. max. 359°; Def. 359°)
Angular position of the needle at which the thread cutting knife is switched 
off
Thread tension during thread cutting 
(min. = 00 .. max. 100; Def. 10 %)
Thread tension of the cutting stitch

Position for thread tension during thread cutting 
(min. = 0° .. max. 400°; Def. 370°)
Starting angle for the thread tension during the cutting stitch
(At an angle greater than 359° the thread tension is activated in the next stitch.)

MP5 - Thread clamping

Symbol Meaning

Close thread clamp at 1st stitch 
(min. = 0° .. max. 250°; Def. 180°)
Start angle for closing the thread clamp during the first stitch

Open thread clamp at 1st stitch 
(min. = 0° .. max. 359°; Def. 340°)
Starting angle for opening the thread clamp during the first stitch.
If the closing and opening angles are the same then the thread clamp is not 
activated

Symbol Meaning
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Information
The remaining thread monitor (MP 1, Optionale Einrichtungen (Optional 
equipment)) and the bobbin counter (MP 6) can be activated simultane-
ously. The display shows the two options as follows:

Fig. 48: Remaining thread monitor and bobbin counter

MP6 - Counters

Symbol Meaning

Counter type 
The following options are available:
• Increment counter (Def.): The counter is incremented after each sewn 

program
• Decrement counter: The counter is decremented after each sewn 

program
• Increment seam sequence counter: The counter is incremented after 

each seam sequence sewn
• Decrement seam sequence counter: The counter is decremented after 

each seam sequence sewn
Reset value for the counter
(min. = 0 .. max. 9999; Def. 0)
Value to which the counter is set when a counter reset is performed

Set seam count for bobbin reserve
(min. = 0 .. max. 100; Def. 0)
A message is displayed to the user after the number of seams specified 
here have been sewn. A value of 0 deactivates the function
Bobbin supply capacity
(min. = 0.0 .. max. 400.0; Def. 0.0 m)
A message is displayed to the user after the bobbin supply capacity has 
been consumed. A value of 0 deactivates the function

(1) - Display - remaining thread monitor:
Remaining thread monitor active: 
R shown
Remaining thread monitor inactive: 
R hidden

(2) - Display - bobbin counter:
Bobbin counter active: Number black
Bobbin counter inactive: 
Number grayed-out

① ②
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5.12 Checking and changing the technical settings
The technical settings are made via the menu item Extras > 
Service.

Fig. 49: Checking and changing the technical settings

Important
A password must always be entered in order to access the additional 
menu items in Extras > Service ( p. 38).

5.12.1 Changing the password options
The default password on delivery is: 25483.

You can change this password and also define whether the password only 
applies to the technical menu items or must always be entered after the 
machine is switched on.

Changing the password
To change the password:

1. Press the menu items Extras > Service > Einstellungen 
(Settings).

 The Einstellungen (Settings) window appears.

2. Press the Operator Passwort (Password) option.

3. In the following window press the option Passwort ändern 
(Change password).

 The window for entering the new password appears.
4. Enter the new password ( p. 38).
Important
The password must not have more than 5 digits.

5. Confirm the new password with OK.
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Defining the password protected areas
To define the password protected areas:

1. Press the menu items Extras > Service > Einstellungen 
(Settings).

 The Einstellungen (Settings) window appears.

2. Press the Operator Passwort (Password) option.

 In the next window the Aktivieren/De-aktivieren 
(Activate/Deactivate) option indicates the type of 
password protection:

•   - Comprehensive password protection activated: 
Password protection of the first action after switching on

•   - Comprehensive password protection deactivated:
Password protection for the technical menu items only 

3. Press the Aktivieren/De-aktivieren (Activate/
Deactivate) option to switch between each respective setting.

4. Confirm with OK.
Important
Switch off and on again the machine to adopt the setting.

5.12.2 Changing the language
To change the language:

1. In the menu item Extras > Service > Einstellungen 
(Settings) press the Sprache (Language) option.

 The list of available languages is displayed.
2. Press the desired language.
3. Confirm with OK.
 The screen is reloaded in the selected language.

5.12.3 Setting date and time
To set date and time:

1. In the menu item Extras > Service > Einstellungen 
(Settings) press the option Datum (Date) und (and) 
Uhrzeit (Time).

 The data entry window for date and time is displayed.
2. Enter the date and/or time.
3. Confirm with OK.
 The entered values are adopted.
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5.12.4 Setting the brightness
To set the brightness:

1. In the menu item Extras > Service > Einstellungen 
(Settings) press the Bedienfeld-Einstellungen 
(Control panel settings) option.

2. In the following window press the Kontrast (Contrast) 
Helligkeit (Brightness) option.

 A window with slider controls is displayed.
3. Pull the corresponding slider control up or down to change the value.
 The changes are immediately visible on the display.

5.12.5 Testing the touchscreen
You can use the Extras > Service > Einstellungen 
(Settings) menu item to check that the touchscreen is functioning 
correctly over all areas of the screen.

To test the touchscreen:

1. In the menu item Extras > Service > Einstellungen 
(Settings) press the Bedienfeld-Einstellungen 
(Control panel settings) option.

2. In the following window press the Touch Test option.
 An empty window is opened.
3. Use your finger to press various different points or draw lines.
 When the touchscreen is functioning correctly all touched points of 

the screen are marked.
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5.13 Testing the functions of the machine
You can use the Extras > Service > Multitest (Multi 
test) menu item to check the inputs and outputs, test the sewing motor 
and set the stroke position.

Fig. 50: Testing the functions of the machine

Information

The  Transportklammer (Transport clamp) function 
is only intended for use by Dürkopp Adler Service personnel.

5.13.1 Testing inputs and outputs

Important
The instructions only provide an overview of the test possibilities.

The tests may only be performed by qualified specialists that have re-
ceived training from Dürkopp Adler.

To test inputs and outputs:

1. In the menu item Extras > Service > Multitest (Multi 
test) press the Eingänge / Ausgänge testen (Test 
inputs / outputs) option.

 The IO Test Seite (Page) window is displayed.

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Do NOT reach into the machine during function 
testing of inputs and outputs.
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Fig. 51: Testing inputs and outputs

The input elements are listed and selected at the left side (1) and the 
output elements at the right side (2).

2. For the 1st time: Press the button ausgewählt: (selected:) 
and select an output.

3. Next, use Auswahl (Select) + or Auswahl (Select) - 
to select the desired element in the respective area.

 The number of the element is displayed on the ausgewählt: 
(selected:) button.

4. Test the element using the Ein/Aus (On/Off) or umschalten 
(switchover) buttons, depending on the type of the input or output 
element.

(1) - Area for input elements (2) - Area for output elements

① ②

Input elements

No. Meaning

S1 Lower right clamp
S2 Lower left clamp
S9 Needle thread monitor active
S10 Hook cover closed
S11 Machine head latch closed
S13 Pedal forwards
S14 Pedal backwards
S16 Pressure switch
S17 Quick-stop
S100 Sewing motor reference
S101 X-axis reference
S102 Y-axis reference
S103 Z-axis reference
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5.13.2 Adjusting the stroke position

To adjust the stroke position:

1. In the menu item Extras > Service > Multitest (Multi 
test) press the Hublage einstellen (Set stroke 
position) option.

 The following options are displayed:

Output elements

No. Meaning

Y1 Foot mode
Y2 Hook cover
Y3 Needle cooling on
Y4 Right clamp
Y5 Left clamp
Y8 Stitch position optimization
Y9 Threading switch lamp on
Y10 Oil level indicator warning light on
Y25 Marking lamp 1 (Z)
Y26 Marking lamp 2 (Z)
Y27 Marking lamp 3 (Z)
Y28 Marking lamp 4 (Z)

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Do not reach into the machine when setting the 
stroke position.
Switch off the power to the drives when you wish to 
test the freedom of motion of the sewing foot rod.

Symbol Meaning

Perform a reference run
Check the movement

Switch between jumping foot and presser foot
Switch over the mode of operation
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2. Press the desired symbol and execute the function.

5.13.3 Testing the sewing motor

To test the sewing motor:

1. In the menu item Extras > Service > Multitest (Multi 
test) press the Nähmotor testen (Test sewing 
motor) option.

 The sewing motor test screen is displayed:

Fig. 52: Testing the sewing motor

Important
Remove the thread from the needle and the thread lever before starting 
the test.

2. Press the  button.

 The window for entering the speed opens.

Go to position
Adjust the sewing foot height

Switch off the power to the drives
Manually check the freedom of motion of the sewing foot rod

Symbol Meaning

WARNING
Risk of injury from sharp and moving parts!
Puncture or crushing possible.

Do not reach into the machine during the function 
test of the motor.
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3. Enter the desired value (300 - 2000 rpm).

4. Press the  button.

 The window for entering the cutting speed opens.
5. Enter the desired value (70 - 500 rpm).

6. Press the  button.

 The sewing motor runs at the entered speed.

7. Press the  button.

 The sewing motor stops.

8. Press the  button.

 The sewing motor runs at the entered speed.

9. Press the  button.

 The sewing motor stops, and the thread trimmer is actuated.

5.13.4 Calling up log displays and error lists
You can access the log settings and error lists via Extras > Service > 
System-Information (System Information).

To call up log displays and error lists:

1. Press the menu items Extras > Service > System-
Information (System Information).

 The selection screen for system information appears.

Fig. 53: Calling up log displays and error lists

2. Press the desired symbol.
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5.14 Initializing the control and performing updates
You can use Extras > Service > Initialisierung 
(Initialization) and Update to reset the control and control 
panel to the factory defaults and to update the control with a new software 
version.

To initialize the control and perform updates:

1. Press the menu items Extras > Service > Initialisierung 
(Initialization) and Update.

 The screen for initialization and update appears.

Fig. 54: Initializing the control and performing updates

Symbol Meaning

Control unit events
List of the latest errors

Log configuration
Only for Dürkopp Adler Service personnel

Log display
List of the last log settings

State of control panel
Status appears in the log display
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5.14.1 Initializing the control
Important
Initializing the control resets all values to the factory default settings. 
All changes are lost. 
Only execute this option if you really want to return to the factory settings.

Order
Save your seam programs and seam sequences to a USB key before 
performing initialization.

1. Press the Initialisierung (Initialize)  Steuerung 
(Control) option.

 The control is completely reset to the factory default settings.

5.14.2 Initializing the control panel
Important
Initializing the control panel resets all values to the factory default settings. 
All changes are lost. 
Only execute this option if you really want to return to the factory settings.

1. Press the Initialisierung des Bedienfelds 
(Initialize control panel) option.

 The control panel is completely reset to the factory default settings.

5.14.3 Performing an update of the control

Information
The latest software version is available in the download area at
www.duerkopp-adler.com.

You can easily transfer a new software version from a USB key to the 
control.

Important
Not all commonly available USB keys are suitable for the copying process.
You can obtain a suitable USB key from Dürkopp Adler.

To perform an update of the control:

1. Switch off the machine.
2. Insert the USB key into the USB port (1) on the control panel.
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Fig. 55: Performing an update of the control

3. Switch on the machine.
 The software update is performed automatically.

Information
If the automatic update does not function then you can use the menu items 
Extras > Service > Initialisierung (Initialize) 
and Update > Update der (the) Steuerung (control) 
to load a specific software version.

Contact the Dürkopp Adler Service Hotline for this.

Displaying software version information
The menu item ? displays information on the software currently installed 
on the machine.

To display information on the software version currently used:

1. Press menu items ? > Press on Info.
 The following information is displayed:

• Class
• Subclass
• Software version
• Date of creation of this software version

5.15 DACCAD professional
You can use the DACCAD professional program to create seam programs 
on a PC ( Operating Instructions DACCAD professional).

(1) - USB port

①

86 Operating Instructions 911-210-10 - 03.0 - 09/2021



Maintenance
6 Maintenance

This chapter describes maintenance work that needs to be carried out 
on a regular basis to extend the service life of the machine and achieve 
the desired seam quality.

Advanced maintenance work may only be carried out by qualified special-
ists ( Service Instructions).

Maintenance intervals

WARNING
Risk of injury from sharp parts!
Punctures and cutting possible.

Prior to any maintenance work, switch off the 
machine or set the machine to threading mode.

WARNING
Risk of injury from moving parts!
Crushing possible.

Prior to any maintenance work, switch off the 
machine or set the machine to threading mode.

Work to be carried out Operating hours

8 40 160 500

Cleaning

Removing sewing dust and thread residues 

Cleaning the motor fan mesh 

Lubricating

Lubricating the machine head 

Lubricating the hook 

Servicing the pneumatic system

Adjusting the operating pressure 

Draining the water condensation 

Cleaning the filter element 

Servicing specific components

Checking the toothed belt 
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6.1 Cleaning

6.1.1 Cleaning the machine
Sewing dust and thread residues should be removed after every 8 operating 
hours using a compressed air gun or a brush. If very fluffy sewing material 
is being sewn, the machine must be cleaned more frequently.

Fig. 56: Cleaning the machine

WARNING
Risk of injury from flying particles!
Flying particles can enter the eyes, causing injury.

Wear safety goggles.
Hold the compressed air gun so that the particles 
do not fly close to people.
Make sure no particles fly into the oil pan.

NOTICE

Property damage from soiling!
Sewing dust and thread residues can impair the operation of 
the machine.

Clean the machine as described.

NOTICE

Property damage from solvent-based cleaners!
Solvent-based cleaners will damage paintwork.

Use only solvent-free substances for cleaning.

(1) - Area around the needle
(2) - Hook

(3) - Area under the throat plate
(4) - Knife on the winder

①

② ③

④
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Areas particularly susceptible to soiling:
• Knife on the winder (4)
• Area under the throat plate (3)
• Hook (2)
• Area around the needle (1)

To clean the machine:

1. Remove any dust and thread residues using a compressed air gun or 
a brush.

6.1.2 Cleaning the motor fan mesh
The motor fan mesh must be cleaned once a month using a compressed 
air gun. If very fluffy sewing material is being sewn, the motor fan mesh 
must be cleaned more frequently.

Fig. 57: Cleaning the motor fan mesh 

To clean the motor fan mesh:

1. Remove any sewing dust and thread residues using a compressed air 
gun.
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6.2 Lubricating

The machine is equipped with a central oil-wick lubrication system. 
The bearings are supplied from the oil reservoir.

For topping off the oil reservoir, use only lubricating oil DA 10 or oil of 
equivalent quality with the following specifications:

• Viscosity at 40 °C: 10 mm²/s
• Flash point: 150 °C
You can order the lubricating oil from our sales offices using the following 
part numbers:

CAUTION
Risk of injury from contact with oil!
Oil can cause a rash if it comes into contact with 
skin.

Avoid skin contact with oil.
If oil has come into contact with your skin, wash 
the affected areas thoroughly.

NOTICE

Property damage from incorrect oil!
Incorrect oil types can result in damage to the machine.

Only use oil that complies with the data in the instructions.

CAUTION
Risk of environmental damage from oil!
Oil is a pollutant and must not enter the sewage 
system or the soil.

Carefully collect up used oil.
Dispose of used oil and oily machine parts in 
accordance with national regulations.

Container Part no.

250 ml 9047 000011

1 l 9047 000012

2 l 9047 000013

5 l 9047 000014
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6.2.1 Lubricating the machine head
Proper setting
The oil level is between the minimum level marking and the maximum 
level marking.

Fig. 58: Lubricating the machine head

To lubricate the machine head:

1. Check the oil level indicator every day.
2. If the oil level is below the minimum level marking (3):

Top off oil through the refill opening (1) but no higher than the maximum 
level marking (2).

(1) - Refill opening
(2) - Maximum level marking

(3) - Minimum level marking

①

②

③
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6.2.2 Lubricating the hook
The approved oil quantity for hook lubrication is a factory specification. 

Proper setting
1. Hold a piece of blotting paper next to the hook (1) while sewing.
 After sewing a stretch of approx. 1 m, the blotting paper will have 

been sprayed with a thin and even film of oil.

Fig. 59: Lubricating the hook

To lubricate the hook:

1. Turn the screw (2):
• more oil: turn counterclockwise
• less oil: turn clockwise

Important
The released amount of oil does not change until the operating time has 
run a few minutes. Sew for several minutes before you check the setting 
again.

(1) - Hook (2) - Screw

①

②
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6.3 Servicing the pneumatic system

6.3.1 Adjusting the operating pressure

Proper setting
Refer to the Technical Data ( p. 121) chapter for the permissible 
operating pressure. The operating pressure cannot deviate by more than 
± 0.5 bar.

Check the operating pressure on a daily basis.

Fig. 60: Adjusting the operating pressure

To adjust the operating pressure:

1. Pull the pressure regulator (1) up.
2. Turn the pressure regulator until the pressure gage (2) indicates the 

proper setting:
• Increase pressure = turn clockwise
• Reduce pressure = turn counterclockwise

3. Push the pressure regulator (1) down.

NOTICE

Property damage from incorrect adjustment!
Incorrect operating pressure can result in damage to the machine.

Ensure that the machine is only used when the operating pressure 
is set correctly.

(1) - Pressure regulator (2) - Pressure gage

①

②
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6.3.2 Draining the water-oil mixture

The collection tray (2) of the pressure regulator will show accumulation of 
a water-oil mixture.

Proper setting
The water-oil mixture must not rise up to the level of the filter element (1).

Check the level of the water-oil mixture in the collection tray (2).

Fig. 61: Draining the water-oil mixture

To drain the water-oil mixture:

1. Disconnect the machine from the compressed air supply. 
2. Place the vessel under the drain screw (3).
3. Loosen the drain screw (3) completely.
4. Allow the water-oil mixture to drain into the vessel.
5. Tighten the drain screw (3).
6. Connect the machine to the compressed air supply.

NOTICE

Property damage from excess liquid!
Too much liquid can result in damage to the machine.

Drain liquid as required.

(1) - Filter element
(2) - Collection tray

(3) - Drain screw

①

② ③
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6.3.3 Cleaning the filter element

Fig. 62: Cleaning the filter element

To clean the filter element:

1. Disconnect the machine from the compressed air supply.
2. Drain the water-oil mixture ( p. 94).
3. Unscrew the collection tray (2).
4. Unscrew the filter element (1).
5. Blow out the filter element (1) using the compressed air gun.
6. Wash out the filter tray using benzine.
7. Tighten the filter element (1).
8. Tighten the collection tray (2).
9. Tighten the drain screw (3).
10. Connect the machine to the compressed air supply.

NOTICE

Damage to the paintwork from solvent-based cleaners!
Solvent-based cleaners damage the filter. 

Use only solvent-free substances for washing out the filter tray.

(1) - Filter element
(2) - Collection tray

(3) - Drain screw

①

② ③
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6.4 Servicing specific components

Checking the toothed belt

The condition of the toothed belt must be checked once a month.

Important
A damaged toothed belt must be replaced immediately.

Proper setting
The toothed belt exhibits no cracks or fragile areas.
When pressed with a finger, the toothed belt must yield no more than 
10 mm.

6.5 Parts list
A parts list can be ordered from Dürkopp Adler. Or visit our website for 
further information at:

www.duerkopp-adler.com

WARNING
Risk of injury from moving parts!
Crushing possible.

Switch off the machine before checking the 
condition of the toothed belt.
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7 Setup

7.1 Checking the scope of delivery
The scope of delivery depends on your specific order. Check that the 
scope of delivery is correct after taking delivery.

WARNING
Risk of injury from cutting parts!
Cutting injuries may be sustained while unpacking 
and setting up the machine.

Only qualified specialists may set up the machine.
Wear safety gloves.

WARNING
Risk of injury from moving parts!
Crushing injuries may be sustained while 
unpacking and setting up the machine.

Only qualified specialists may set up the machine.
Wear safety shoes.
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7.2 Transporting the machine

Important
While being transported, the machine must always be in transport position 
(height adjustment all the way down).

Different stands are provided, depending on the order:

• Stand with rollers
• Stand without rollers

Stands without rollers must be transported with a lifting carriage or 
stacker.

WARNING
Risk of injury from moving parts!
Crushing possible.

The machine is heavy.
ALWAYS use a lifting carriage or stacker for lifting 
the machine to avoid back injuries or crushing 
injuries if the machine falls down.

WARNING
Risk of injury from unsafe positioning of the 
machine!
Crushing possible.

Before commissioning all stand variants ensure 
that the stand feet are turned out sufficiently and 
the nuts are tightened so that the machine stands 
securely.
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Fig. 63: Transporting the machine

To transport a machine with rollers:

1. Loosen the nuts (1).
2. Rotate the stand feet (2) fully upwards.
3. Tighten the nuts (1) so that the stand feet (2) remain upwards.
4. Roll the machine to the desired setup location.
5. Loosen the nuts (1).
6. Rotate the stand feet (2) downwards so that the stand is supported 

evenly and firmly on all 4 stand feet (2).
7. Tighten the nuts (1).

To transport a machine without rollers:

1. Load the machine onto a lifting carriage or stacker.
2. Move the machine to the desired setup location.

(1) - Nut (2) - Stand foot

①

②
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7.3 Adjusting the working height

7.3.1 Adjusting the working height for stands with rollers
The working height is continuously adjustable between 800 and 1050 mm 
(clearance between the floor and upper edge of the tabletop).

Fig. 64: Adjusting the working height for stands with rollers

To adjust the working height for stands with rollers:

1. Support the unit with a lifting carriage or stacker.
2. Loosen the screws (1) on the table legs.

WARNING
Risk of injury from moving parts!
The tabletop can sink under its own weight when 
the screws on the stand bars are loosened. 
Crushing possible.

Ensure that your hands are not jammed when 
loosening the screws.

CAUTION
Risk of musculoskeletal damage from incorrect 
setting!
The operator can sustain musculoskeletal damage 
if failing to comply with the ergonomic 
requirements.

Adjust the working height to the body height of the 
person who will operate the machine.

(1) - Screws

①
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3. Adjust the tabletop to the desired working height.
Important
Pull out or push in the stand tubes evenly on both sides to prevent 
jamming.

4. Tighten the screws (1).
5. Remove the lifting carriage or stacker.

7.3.2 Adjusting the working height for stands without rollers
The working height is continuously adjustable between 760 and 910 mm 
(clearance between the floor and upper edge of the tabletop).

Fig. 65: Adjusting the working height for stands without rollers

To adjust the working height for stands without rollers:

1. Support the unit with a lifting carriage or stacker.
2. Loosen the nuts (2) on the table legs.
3. Adjust the tabletop level to the desired working height by turning 

the threaded rods (1).
Important
Turn the threaded rods (1) evenly at both sides to prevent jamming.

4. Tighten the nuts (2).
5. Remove the lifting carriage or stacker.

(1) - Threaded rod (2) - Nut

②

①
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7.4 Adjusting the pedal
The pedal can be freely positioned in front of the machine as far as the 
cable allows.

Fig. 66: Adjusting the pedal

To adjust the pedal:

1. Position the pedal (1) in front of the machine so that pedal and machine 
can be comfortably operated.

(1) - Pedal

①
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7.5 Assembling the reel stand

Fig. 67: Assembling the reel stand

To assemble the reel stand:

1. Insert the reel stand (1) into the hole in the tabletop.
2. Assemble the reel stand (1) to the tabletop using the nuts (2).
3. Assemble the thread reel holder (3) and the thread guide (4) onto 

the reel stand in such a way that they are located precisely above one 
another.

(1) - Reel stand
(2) - Nut

(3) - Thread reel holder
(4) - Thread guide

①

② ③

④

①

③

②
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7.6 Assembling the rear machine cover
(911-210-6055-10 only)

Fig. 68: Assembling the rear machine cover (1)

To assemble the rear machine cover:

1. Loosen the 4 screws (1).

Fig. 69: Assembling the rear machine cover (2)

2. Slide the cover (2) onto the screws (1) as far as it will go.

(1) - Screws

①①

(1) - Screws (2) - Cover

①

②
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Fig. 70: Assembling the rear machine cover (3)

3. Tighten the screws (1).

7.7 Electrical connection

7.7.1 Checking the rated voltage
To check the rated voltage:

1. Check the mains voltage before connecting the machine.

7.7.2 Establishing the electrical connection
To establish the electrical connection:

1. Connect the power plug.

(2) - Cover

②

DANGER
Risk of death from live components!
Unprotected contact with electricity can result in 
serious injuries or death.

Only qualified specialists may perform work on 
electrical equipment.
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7.8 Pneumatic connection

The pneumatic system of the machine and of the additional equipment must 
be supplied with dry and oil-free compressed air. The supply pressure must 
lie between 8 and 10 bar.

7.8.1 Assembling the compressed air maintenance unit

Fig. 71: Assembling the compressed air maintenance unit

To assemble the compressed air maintenance unit:

1. Connect the connection hose (2) to the compressed air supply using 
a hose coupling R 1/4”.

NOTICE

Property damage from oily compressed air!
Oil particles in the compressed air can cause malfunctions of 
the machine and soil the sewing material.

Ensure that no oil particles enter the compressed air supply.

NOTICE

Property damage from incorrect adjustment!
Incorrect system pressure can result in damage to the machine.

Ensure that the machine is only used when the system pressure is 
set correctly.

(1) - Connection hose

①
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7.8.2 Adjusting the operating pressure

Proper setting
Refer to the Technical Data ( p. 121) chapter for the permissible 
operating pressure. The operating pressure cannot deviate by more than 
± 0.5 bar.

Fig. 72: Adjusting the operating pressure

To adjust the operating pressure:

1. Pull the pressure regulator (1) up.
2. Turn the pressure regulator until the pressure gage (2) indicates 

the proper setting:
• Increase pressure = turn clockwise
• Reduce pressure = turn counterclockwise

3. Push the pressure regulator (1) down.

NOTICE

Property damage from incorrect operating pressure!
Incorrect operating pressure can result in damage to the machine.

Ensure that the machine is only used when the operating pressure 
is set correctly.

(1) - Pressure regulator (2) - Pressure gage

①

②
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7.9 Performing a test run
When setup is complete, perform a test run to check the functionality of 
the machine.

To perform a sewing test:

1. Switch off the machine.
2. Thread the needle thread ( p. 22).
3. Insert the bobbin ( p. 26).
4. Switch on the machine.
 The control is initialized.
5. Press the pedal forwards.
 The reference run starts.

The transport carriage moves to the reference position.

Information
The reference run is necessary in order to obtain a defined starting 
position of the transport carriage.
Pressing the pedal forwards triggers the different steps of the insertion 
procedure one after another and then starts the sewing process.
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8 Decommissioning

To decommission the machine:

1. Switch off the machine.
2. Unplug the power plug.
3. If applicable, disconnect the machine from the compressed air supply.
4. Remove residual oil from the oil pan using a cloth.
5. Cover the control panel to protect it from soiling.
6. Cover the control to protect it from soiling.
7. Cover the entire machine if possible to protect it from contamination 

and damage.

WARNING
Risk of injury from a lack of care!
Serious injuries may occur.

ONLY clean the machine when it is switched off.
Allow ONLY trained personnel to disconnect the 
machine.

CAUTION
Risk of injury from contact with oil!
Oil can cause a rash if it comes into contact with 
skin.

Avoid skin contact with oil.
If oil has come into contact with your skin, wash the 
affected areas thoroughly.
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9 Disposal

The machine must not be disposed of in the normal household waste.

The machine must be disposed of in a suitable manner in accordance with 
all applicable national regulations.

When disposing of the machine, be aware that it consists of a range of 
different materials (steel, plastic, electronic components, etc.). Follow the 
national regulations when disposing these materials.

CAUTION
Risk of environmental damage from improper 
disposal!
Improper disposal of the machine can result in 
serious environmental damage.

ALWAYS comply with the national regulations 
regarding disposal.
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10 Troubleshooting

10.1 Customer Service
Contact for repairs and issues with the machine:

Dürkopp Adler GmbH
Potsdamer Str. 190
33719 Bielefeld, Germany

Tel. +49 (0) 180 5 383 756
Fax +49 (0) 521 925 2594
Email: service@duerkopp-adler.com
Internet: www.duerkopp-adler.com

10.2 Messages of the software

Code Description Troubleshooting

Sewing motor

1051 Sewing motor timeout
• Cable to sewing motor reference

switch defective
• Reference switch defective
• Machine head does not move freely 

or has excessive belt tension

• Replace cable

• Replace reference switch
• Check the freedom of movement 

and belt tension of the machine 
head

1052 Sewing motor excess current
• Sewing motor cable defective
• Sewing motor defective
• Control defective

• Replace sewing motor cable
• Replace sewing motor
• Replace control

1053 Sewing motor mains voltage too high Check the mains voltage

1055 Sewing motor overload
• Sewing motor blocked/not moving 

freely
• Sewing motor defective
• Control defective

• Remove blockage/sluggishness
• Check the sewing motor
• Check the control

1056 Sewing motor overtemperature
• Sewing motor not moving freely
• Sewing motor defective
• Control defective

• Eliminate seizing
• Replace sewing motor
• Replace control
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1058
1302
1342

1344 

Sewing motor speed
• Sewing motor defective
Sewing motor error
Control not receiving pulses from 
pulse encoder in motor
Sewing motor error
Internal error 

• Replace sewing motor
• Check the cable from the pulse 

encoder in the motor to the control
• Switch off and on the machine again
• Software update

Stepper motors

2101 X-axis stepper motor referencing 
timeout
• Faulty reference switch setting
• Cable to reference switch

defective
• Reference switch defective

• Align reference switch

• Replace cable
• Check reference switch

2102 X-axis stepper motor current error
• Stepper motor blocked
• Encoder cable not connected or 

defective
• Encoder defective

• Fix blockage
• Check/replace the encoder cable
• Replace the stepper motor

2152 X-axis stepper motor excess current • Replace the stepper motor
• Replace control

2153 X-axis stepper motor overvoltage
• Mains voltage too high

• Check mains voltage

2155 X-axis stepper motor overload
• Feed system not moving freely
• Obstacle to feed movement

• Eliminate sluggishness
• Remove obstacles/adjust the motion

2156 X-axis stepper motor overtemperature
• Stepper motor sluggish
• Stepper motor faulty
• Control defective

• Eliminate seizing
• Replace the stepper motor
• Replace control

2201 Y-axis stepper motor referencing 
timeout
• Faulty reference switch setting
• Cable to reference switch

defective
• Reference switch defective

• Align reference switch

• Replace cable
• Replace reference switch

2202 Y-axis stepper motor current error
• Stepper motor blocked
• Encoder cable not connected or 

defective
• Encoder defective

• Fix blockage
• Check/replace the encoder cable
• Replace the encoder

2252 Y-axis stepper motor excess current • Replace the stepper motor
• Replace control

2253 Y-axis stepper motor overvoltage
• Mains voltage too high • Check mains voltage

Code Description Troubleshooting
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2255 Y-axis stepper motor overload
• Feed system not moving freely
• Obstacles to the feed motion

• Eliminate sluggishness
• Remove obstacles/adjust the motion

2256 Y-axis stepper motor overtemperature
• Feed system not moving freely
• Stepper motor faulty
• Control defective

• Eliminate seizing
• Replace the stepper motor
• Replace control

2301 Stroke position stepper motor 
referencing timeout
• Faulty reference switch setting
• Cable to reference switch defective
• Reference switch defective 

• Align reference switch

• Replace cable
• Replace reference switch

2302 Stroke position stepper motor current 
error
• Stepper motor blocked
• Encoder cable not connected or 

defective
• Encoder defective

• Fix blockage
• Check/replace the encoder cable
• Replace the encoder

2352 Stroke position stepper motor excess 
current

• Replace the stepper motor
• Replace control

2353 Stroke position stepper motor 
overvoltage
• Mains voltage too high

• Check mains voltage

2355 Stroke position stepper motor overload
• Feed system not moving freely
• Obstacles to the feed motion

• Eliminate sluggishness
• Remove obstacles/adjust the motion

2356 Stroke position stepper motor 
overtemperature
• Feed system not moving freely
• Stepper motor faulty
• Control defective

• Eliminate sluggishness
• Replace the stepper motor
• Replace control

Machine control

3100 Machine control voltage 
• Temporary mains voltage 

interruption 
• Check the mains voltage

3102 Machine voltage in sewing motor 
intermediate circuit 
• Temporary mains voltage 

interruption 
• Check the mains voltage

3103 Machine voltage in stepper motor 
intermediate circuit 
• Temporary mains voltage 

interruption 
• Check the mains voltage

3107 Machine temperature 
• Ventilation openings closed
• Ventilation grille dirty

• Clean ventilation grille
• Check ventilation openings

3109 Threading mode is switched on Switch off threading mode

3121 Compressed air is missing, not 
sufficient

Turn up air pressure and stabilize

Code Description Troubleshooting
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Troubleshooting
3123 Oil sensor active Top off the oil

3210 Thread broken Re-thread the thread

3215 Bobbin empty (remaining thread 
counter)

Insert full bobbin

3220 Bobbin empty (remaining thread 
counter)

Insert full bobbin

3500 Error in calculating the contour data • Reload the contour data
• Check the contour data

3501 Target position of the XY clamps 
outside the motion limits 

Adjust the contour data

3502 Target position of the XY clamps within 
the "forbidden areas"

Adjust the contour data

3721
3722 

Internal error • Switch off and on the machine
• Software update
• Notify DA Service

4201 Internal CF card defective • Switch off and on the machine
• Retrofit/replace control

5301 Program cannot be sewn Copy program to DAC

6551

6554
6651

6653
6751

6761

Error in machine head position/AD 
converter/process error

Internal error

• Switch off and on the machine
• Software update

• Notify DA Service

6952 Stepper motor driver error
Internal error

• Switch off and on the machine
• Software update
• Notify DA Service

Communication

7801 Control panel interface communication
• Cable disturbance
• Cable 

• Switch off and on the machine
• Software update
• Notify DA Service

8151
8156

8159

IDMA error
• Disturbance
• Control defective

• Switch off and on the machine
• Replace control

 8152

8154

IDMA error
• Internal error

• Switch off and on the machine
• Software update
• Notify DA Service

8252
8257
8258

8256
8254

ADSP Boot/Xilinx Boot/ Boot error
Disturbance

• Switch off and on the machine

Code Description Troubleshooting
116 Operating Instructions 911-210-10 - 03.0 - 09/2021



Troubleshooting
8351 Test pins error • Switch off and on the machine
• Software update
• Notify DA Service

8400 Control panel has no valid program 
for the DAC.

Load the current program into the 
control panel from a USB key.

8401
8402

Control panel has no valid program 
for the DAC.

Load the current program into the 
control panel from a USB key.

8403 Program in DAC is no longer current. Load the current program into the 
DAC.

8404

8407

DAC update was faulty. • Attempt the update again
• Check cable connection
• Replace the DAC

8408 Waiting for a DAC reset. Wait until the restart has been 
performed 
(Duration: several seconds).

8411 DAC program check is active. Wait until the test has been performed 
(Duration: several seconds).

8414 DAC update succeeded.

8801

8805
8806
8890
8891

Error in test pins/signal processing/
event processing/
Memory wrapper/
list functions
Internal error

• Switch off and on the machine
• Software update
• Notify DA Service

System

9000 Reference run active

9002 Machine head not locked Lock machine head

9006 Quick-stop switch is activated. Releasing the quick-stop switch

9016 Wrong bar code ID Change the program

9100 The counter has not reached the 
default value.

Press the OK button. The counter is 
reset.

9601 Stop while sewing on the contour
Continue sewing?

• OK button = 
Continuing the sewing process

• ESC button = 
Canceling the sewing process

9700 Bobbin case retainer for bobbin 
change not closed

Close the bobbin case retainer for 
bobbin change

9701 Parallel clamps not lowered • Remove obstacles
• Align sensors

9900 Incorrect machine parameters Initialize the data

9901 Incorrect sequences Initialize the data

9902 Incorrect program parameters Initialize the data

Code Description Troubleshooting
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Troubleshooting
10.3 Errors in sewing process

Error Possible causes Remedial action

Unthreading at seam 
beginning

Needle thread tension is 
too firm

Check needle thread tension

Thread breaking Needle thread and hook 
thread have not been 
threaded correctly

Check threading path

Needle is bent or sharp-
edged

Replace needle

Needle is not inserted 
correctly into the needle 
bar

Insert the needle correctly into 
the needle bar

The thread used is 
unsuitable

Use recommended thread

Thread tensions are too 
tight for the thread used

Check thread tensions

Thread-guiding parts, such 
as thread tube, thread 
guide or thread take-up 
disk, are sharp-edged

Check threading path

Throat plate, hook or 
spread have been 
damaged by the needle

Have parts reworked by qualified 
specialists

Skip stitches Needle thread and hook 
thread have not been 
threaded correctly

Check threading path

Needle is blunt or bent Replace needle

Needle is not inserted 
correctly into the needle 
bar

Insert the needle correctly into 
the needle bar

The needle thickness used 
is unsuitable

Use recommended needle 
thickness

The reel stand is 
assembled incorrectly

Check the assembly of the reel 
stand

Thread tensions are too 
tight

Check thread tensions

Throat plate, hook or 
spread have been 
damaged by the needle

Have parts reworked by qualified 
specialists
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Troubleshooting
Loose stitches Thread tensions are not 
adjusted to the sewing 
material, the sewing 
material thickness or the 
thread used

Check thread tensions

Needle thread and hook 
thread have not been 
threaded correctly

Check threading path

Needle breakage Needle thickness is 
unsuitable for the sewing 
material or the thread

Use recommended needle 
thickness

Error Possible causes Remedial action
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Technical data
11 Technical data

11.1 Data and characteristic values

Technical data Unit

91
1-

21
0-

30
20

-1
0

91
1-

21
0-

60
20

-1
0

91
1-

21
0-

60
55

-1
0

Type of stitches 301

Hook type Vertical hook

Number of needles 1

Needle system 134/35

Needle strength [Nm] 80 - 180

Thread strength [Nm] Needle thread 10/3
Hook thread 20/3

Stitch length [mm] up to 12.7, dependent on seam pattern

Speed maximum [min-1] 2700 intermittent 2000 
intermittent

Needle bar stroke [mm] 40

Clamp stroke [mm] 20

Sewing foot stroke [mm] 20

Sewing field size [mm] 300 x 200 600 x 200 600 x 550

Number of free seam contours 99

Mains voltage [V] 230

Mains frequency [Hz] 50/60

Operating pressure [bar] 6

Air consumption [NL/min] 8

Length [mm] 1200 1760

Width [mm] 1200 1360

Height [mm] 875-1275 760-910
(without height 

adjustment)
800-1150

(with height 
adjustment)

Weight [kg] 225 275
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Technical data
11.2 Requirements for fault-free operation
Compressed air quality must conform to ISO 8573-1: 2010 [7:4:4].
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Appendix
12 Appendix

12.1 Wiring diagram - remaining thread monitor
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Appendix
12.2 Wiring diagram
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